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ABOUT THIS MANUAL 

READ THIS OPERATING MANUAL BEFORE ATTEMPTING TO USE THE INSTRUMENT. 
 

This manual is valid for the Otosure (applies from serial number 58000 and Audibase version 5.5 onwards). 

This product is manufactured by:  
Amplivox Ltd. 

10393 West 70th Street 
Eden Prairie 

 
MN 55344 

United States 
 

Amplivox Ltd. 
3800 Parkside, Solihull Parkway, 

Birmingham Business Park, 
Birmingham, West Midlands,  

B37 7YG 
United Kingdom  

www.amplivox.com 

For all enquiries please contact us under: 

Tel: 888 941 4208 
Fax: 952 903 4100 

info@amplivox.us 

Tel: +44 (0)1865 880846 
 

hello@amplivox.com 
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1. INTRODUCTION 

1.1. THANK YOU 

Thank you for purchasing an Amplivox audiometer. The Otosure is a compact, automatic air-conduction 

screening audiometer, driven and controlled by a computer (PC). It provides a cost-effective solution for 

today's health care environment. 

 

The Otosure is used with the Amplivox Audibase software, which allows electronic storage of audiometric 

test records on a PC, application of audiogram categorisation schemes, printing of audiograms and data 

exchange with other PC applications. 

 

This operator's manual enables you to take full and safe advantage of the features offered by the Otosure 

audiometer. Therefore, PLEASE READ IT THOROUGHLY before using the audiometer. 

 

1.2. INTENDED APPLICATIONS 

This instrument is designed for use by trained personnel only, such as audiologists, ENT surgeons, doctors, 

general practitioners, hearing aid dispensers, child health professionals and hearing healthcare professionals 

with a similar level of education. It is not recommended to utilize the equipment without the necessary 

knowledge and training.  

 

1.3. CONTRADICTIONS 

Always visually inspect the outer ear and the external auditory canal for abnormalities before testing. Testing 

should not be performed on patients in the following items is applicable.  

1. The presence of other sensitivity to loud sounds may contraindicate testing when high intensity stimuli 
are used. 

2. Recent outer ear surgery. 

 

1.4. STANDARD AND OPTIONAL COMPONENTS 

Shipping documentation will reference the stock number quoted above, and images of the parts alongside the 

relevant stock number are available on the Amplivox website (www.amplivox.com). The required fitting 

instructions are supplied with each part. 

STANDARD COMPONENTS 

Otosure audiometer 8508019 Audiometric headset (DD45) 8509615 

Patient response switch 8011155 HBA audiometric headband 8010882 

Cable USB A to USB B (2.0 m) 8011241 Carrying case  8004651 

Calibration certificate  USB with Audibase Software and 
manuals 

8510705 
and 
8510707 
(OSHA) 

 

 

 

http://www.amplivox.com/
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OTHER COMPONENTS TO REORDER 

Audiocups (noise reducing earphone enclosures) 8010855 Headband (standard 
headphone) 

8010840 

Audiocup ear cushion 8010835 Earphone cushion 8010857 

Audiocup headband 8507381 Earphones DD45 * 8010876 

Audiocup headband cover 8010834 Headset lead 8010822 

Booth Leads 851095   

Accessories marked * require calibration with the specific audiometer to be used. Do not attempt to 

use these accessories until the audiometer has been calibrated to match their characteristics. 

 

Shipping documentation will reference the stock number quoted above, and images of the parts alongside 

the relevant stock number are available on the Amplivox website (www.amplivox.com). The required fitting 

instructions are supplied with each part. 

 

1.5. WARNINGS 

Throughout this manual, the following meanings of warnings and cautions apply: 

 

The WARNING label identifies conditions or practices that may present danger 

to the patient and/or user.  

 

The CAUTION label identifies conditions or practices that could result in damage 

to the equipment. 

 
  

WARNING 

CAUTION 

http://www.amplivox.com/
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2. PRINCIPLES OF OPERATION 

2.1. OTOSCOPIC EXAMINATION 

A suitably-qualified health care professional should perform a thorough otoscopic examination to establish that 
the condition of the ear is suitable for the test options selected and that no contraindications are present. The 
latter would include obstruction of the external ear canal due to excessive wax and/or hairs, both of which 
would need to be removed. This is required to ensure that the probe tone delivered by the probe are able to 
reach the ear drum and are not reflected by cerumen or debris and thereby alter the test result. 
 

2.2. PRINCIPALS OF PURE TONE AUDIOMETRY 

Ideally, hearing tests are conducted in a soundproof room. The purpose of pure tone audiometry is to measure 

the patient’s hearing threshold which is then compared to the hearing threshold of an average normal hearing 

person. The examination starts with air conduction on the ear with better hearing, or if not specified differently, 

on the right ear. The BSA (British Society of Audiology) recommends starting the test at 1000 Hz to then next 

measure the higher frequencies. When done with the high frequencies 1000 Hz shall be retested and to then 

continue with the lower frequencies.  

 

2.3. AUDIOMETRY PREPARATION 

Refer to the various audiometric standards and other relevant publications for guidance on audiometric testing. 

 

Ambient Conditions 

Audiometric testing should always be performed in quiet conditions (e.g. a quiet room or an acoustic booth). 

The optional Audiocups can provide an additional level of isolation from ambient noise.  For further 

explanation on permissible ambient noise levels, please refer to the audiometry standard ISO 6189. 

 

Test System Arrangement 

The schematic diagram below shows a typical example of the use of audiometric test equipment. The 

audiometer is located on the desk of a seated operator as shown. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
The patient is seated in front of the desk facing away from the operator. The patient wears a headset (see 

below) and responds to test stimuli by use of a hand-held switch which is also connected to the instrument. 

 

 

 

 

Operator 

Otosure 

Audiometer 

Computer (e.g. Tablet/Laptop) 

Patient, wearing headset 

 

Headset lead 

Response switch & lead 
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Headset 

The headset must be fitted by a qualified person to ensure a proper seal and comfortable fit. The leads from 

the headset are connected to the instrument and the headset is then fitted to the patient. 

 

Patient Instructions 

The patient is given the following instructions: “Press and then release the response switch when a tone is 

heard”. 
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3. UNPACKING AND INSTALLATION 

3.1. GENERAL 

Please check the contents of the shipping carton against the delivery note to make sure that all items ordered 

have been included. If anything is missing, please contact the distributor who supplied the audiometer or 

Amplivox if purchased directly. 

Please retain the carton and packaging as the instrument will need calibrating on an annual basis and should 

be returned to Amplivox in its original shipping carton. 

 

 

For supply in US only: Federal Law restricts this device to sale by or on the order of a licensed medical 

professional. 

 

3.2. MARKINGS 

The following markings can be found: 

Symbol Explanation 

 

Type B applied parts. According to IEC 60601-1. 
Patient applied parts that are not conductive and can be immediately released from the 
patient. 

 
Refer to instruction manual. 

 

WEEE (EU-directive) 
This symbol indicates that when the end-user wishes to discard this product, it must be 
sent to separate collection facilities for recovery and recycling. Failing to do so may 
endanger the environment. 

 

The CE-mark indicates that Amplivox Ltd. meets the requirements of Annex II of the 
Medical Device Directive 93/42/EEC. TÜV Product Service, Identification No. 0123, 
has approved the quality system. 

 
Serial number. 

 

Date of manufacture. 

 

Manufacturer. 

 

Keep dry. 

 

Transport and storage humidity range. 

CAUTION 
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Transport and storage temperature range. 

 
Logo. 

 

3.3. SAFETY INSTRUCTIONS 

3.3.1. GENERAL 

The following safety precautions must be observed at all times. General safety precautions must be followed 

when operating electrical equipment. Failure to observe these precautions could result in damage to the 

equipment and injury to the operator or patient.  

The employer should instruct each employee in the recognition and avoidance of unsafe conditions and the 

regulations applicable to his or her work environment to control or eliminate any hazards or other exposure to 

illness or injury.  

Amplivox Ltd. is aware that safety rules within individual organizations vary. If a conflict exists between the 

instructions in this manual and the rules of the organization using this instrument, the more stringent rules 

should take precedence.  

The Otosure is intended to be used by hearing healthcare professionals (i.e. ENT doctors, audiologists), nurses 

or technicians who have been trained in the proper use of the device. 

 

3.3.2. CAUTIONS – GENERAL 

 

If the system is not functioning properly, do not operate it until all necessary repairs are made and the unit is 

tested and calibrated for proper functioning in accordance with Amplivox’s specifications. 

Do not drop or in any other way cause undue impact to this device. If the instrument is damaged, return it to 

the manufacturer for repair and/or calibration. Do not use the instrument if any damage is suspected. 

This product and its components will perform reliably only when operated and maintained in accordance with 

the instructions contained in this manual, accompanying labels, and/or inserts. A defective product should not 

be used. Make sure all connections to external accessories are secured properly. Parts which may be broken 

or missing or are visibly worn, distorted, or contaminated should be replaced immediately with clean, genuine 

replacement parts manufactured by or available from Amplivox Ltd. 

Equipment is not user repairable. Repairs must be performed by an authorized service representative only. 

No modifications of the equipment are allowed by anyone other than a qualified Amplivox Ltd. representative. 

Modification of the equipment could be hazardous. 

Amplivox Ltd. will make available on request circuit diagrams, component part lists, descriptions, calibrations 

instructions, or other information that will assist authorized service personnel to repair those parts of this 

instrument that are designated by Amplivox Ltd. as repairable by service personnel.  

CAUTION 
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No parts of the equipment can be serviced or maintained while in use with the patient. 

Connect only accessories purchased from Amplivox Ltd. to the Otosure. Only accessories which have been 

stated by Amplivox Ltd. to be compatible are allowed to be connected to the device or cradle. 

 

3.3.3. ENVIRONMENTAL FACTORS 

 

 

Use and store the instrument indoors only. It is recommended that the instrument 

be operated within an ambient temperature range of 15 °C / 59 °F to 35 °C / 95 °F 

and in relative humidity between 30 % and 90 % (non-condensing). 

Do not use the device in the presence of fluid that can come into contact with any of the electronic components 

or wiring. Should the user suspect fluids have contacted the system components or accessories, the unit 

should not be used until deemed safe by an authorized service technician. 

 

3.3.4. ELECTRICAL AND ELECTROSTATIC SAFETY 

 

Before performing any service to the insert earphones you must uncouple the 

Otosure transducers from the patient. 

 

 

Do not touch the contacts on the back of the instrument and the patient at the 

same time. The consequence could be a too high leakage current to the patient. 

Do not open the case of the instrument. Refer servicing to qualified personnel. 

This equipment is intended to be connected to other equipment thus forming a Medical Electrical System. 

External equipment intended for connection to signal input, signal output or other connectors must comply with 

the relevant product standard e.g. IEC 60950-1 for IT equipment and the IEC 60601-series for medical 

electrical equipment. In addition, all such combinations – Medical Electrical Systems – must comply with the 

safety requirements stated in the general standard IEC 60601-1, (edition 3.1), clause 16. Any equipment not 

complying with the leakage current requirements in IEC 60601-1 must be kept outside the patient environment 

i.e. at least 1.5m from the patient support or must be supplied via a separation transformer to reduce the 

leakage currents. Any person who connects external equipment to signal input, signal output or other 

connectors has formed a Medical Electrical System and is therefore responsible for the system to comply with 

these requirements. If in doubt, contact a qualified medical technician or your local representative. When the 

instrument is connected to a PC, or other similar items, beware of not touching the PC and patient 

simultaneously. 

A Separation Device (isolation device) is needed to isolate the equipment located outside the patient 

environment from the equipment located inside the patient environment. In particular such a Separation Device 

is required when a network connection is made. The requirement for the Separation Device is defined in IEC 

60601-1 clause 16. 

 

 

 

CAUTION 

WARNING 

CAUTION 
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3.3.5. ELECTROMAGNETIC COMPATIBILITY (EMC) 

 

Although the instrument fulfills the relevant EMC requirements, precautions 

should be taken to avoid unnecessary exposure to electromagnetic fields, e.g., 

from mobile phones, etc. If the device is used adjacent to other equipment it 

must be observed that no mutual disturbance appears. Please also refer to the 

appendix regarding EMC. 

 

3.3.6. EXPLOSION HAZARDS  

 

Risk of explosion.  

Do not use in the presence of flammable anesthetics or other gases. 

Do NOT use in the presence of flammable gaseous mixtures. Users should 

consider the possibility of explosions or fire when using this device in close 

proximity to flammable anesthetic gases.  

Do NOT use the Otosure in a highly oxygen-enriched environment, such as a 

hyperbaric chamber, oxygen tent, etc. 

 

3.3.7. MEASURING SECURITY 

To guarantee that the Otosure works properly, the instrument should be checked and calibrated at least once 

a year. The transducers supplied with the audiometer are specifically calibrated with it; if these transducers 

are changed recalibration will be required. 

The service and calibration must be performed by an authorized service technician. If these checks are not 

performed, EU Medical Device Directive (MDD) and other regulations may be violated and warranties may be 

void. 

The use of non-calibrated devices can lead to incorrect test results and is not advisable.  

 

3.3.8. MISCELLANEOUS 

Please note: DO NOT connect the Otosure hardware to the computer before the software has been installed! 

Storage in temperatures below 0C /32F and above 50C /122F may cause permanent damage to the 

instrument and its accessories. 

Do not place the instrument next to a heat source of any kind. 

Great care should be exercised when handling transducers, as rough handling, for example dropping onto a 

hard surface may break or damage the parts. 

 

Within the European Union it is illegal to dispose of electrical and electronic waste as unsorted 
municipal waste. Electrical and electronic waste may contain hazardous substances and 
therefore have to be disposed of separately. Such products will be marked with the crossed-
out wheelie-bin image shown to the left. User cooperation is important in order to ensure a 
high level of reuse and recycling of electrical and electronic waste. Failure to recycle such 
waste products in an appropriate way may endanger the environment and consequently the 
health of human beings. 

Outside the European Union, local regulations should be followed when disposing of the product after its end 

of life. 

CAUTION 

WARNING 
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3.3.9. USE OF EQUIPMENT AFTER TRANSPORT AND STORAGE 

Please make sure that the instrument is functioning correctly before use. If the instrument has been stored in 

a cold environment (even for short period of time), please allow the instrument to become acclimatized. This 

can take long time depending on the conditions (such as environmental humidity). You can reduce the 

condensation by storing the instrument in its original packaging. If the instrument is stored under warmer 

conditions than the actual use conditions no special precaution is required before use. Always ensure proper 

operation of the instrument by following routine check procedures for audiometric equipment. 

 

3.4. CONNECTIONS 

The accessory terminals and connections are labelled to ensure correct identification and connection as 

follows: 

 

SOCKET TYPE COLOUR CODE CONNECTED PART 

6.3mm jack Blue Air conduction headset (Left) * 

6.3mm jack Red Air conduction headset (Right) * 

6.3mm jack Black Patient response Switch * 

USB Connector  N/a Computer (via USB port) 

 Please note: Only connect the accessories supplied with the instrument or supplied by Amplivox or an 

Amplivox distributor. These parts have been tested for use with the Amplivox Otosure audiometer for 

compliance with the standards IEC 60601-1 and IEC 60601-1-2. The use of accessories other than those 

specified may compromise compliance with these standards.  

 

3.5. HARDWARE INSTALLATION 

Refer to Section 11 for important information regarding the connection of non-medical electrical 

equipment to medical electrical equipment. 

The audiometer is powered and controlled by a computer (PC) using software supplied for this 

purpose. This software must be installed before the audiometer is connected to the PC. 

All other connections should be made before connecting the audiometer to the PC. 

 

A USB cable is provided to connect the Otosure to a PC. The connected port on the PC must be to USB 

specification 1.0 or 2.0. Connect the headset and the patient response switch to the Otosure and then make 

the connection from the Otosure to the PC. No specific warm-up time is required although the device 

registration to the PC might take a short time to complete.  

 

 Please note: Please refer to Section 4 for instructions on how to install the software and drivers, how to 

carry out the first-time connection to a PC, and how to undertake a basic operational check to ensure the 

audiometer is functioning correctly. 
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4. INSTALLING SOFTWARE & OPERATIONAL CHECK 

4.1. GENERAL  

This section describes the procedure for installing the Otosure operating software & associated device 

drivers, undertaking the first-time connection of the Otosure audiometer and performing a basic operational 

check to ensure that the instrument is working. 

 

4.2. INSTALLATION 

Installation is a two-stage process (please ensure both are completed): 

1. Install the Otosure software on the PC 

2. Install the device drivers to enable USB communication between the PC and the Otosure audiometer 

 

Step 1: Install the Amplivox Otosure Software 

The installation of the Otosure software is seamless and is installed as part of Audibase. Please refer to the 

Audibase5.x user guide for step by step installation instructions. 

 

Step 2: Install the USB Device Drivers 

Please refer to “D-0115682” Guide to Installing Amplivox USB Drivers 

 

4.3. UNINSTALLING THE OTOSURE PROGRAM 

Uninstalling the Otosure program is achieved simply by navigating to the location where the software was 

originally installed and deleting the file named “Otosure.exe”. There is no need to use the “Add or Remove 

Programs” utility. 

 

This will leave Audibase installed.  

 Please note: If more information about the uninstallation of the Audibase are required, please refer to 

the Audibase5.x user guide. 

 

4.4. OPERATIONAL CHECK 

Connect the headphones and patient response switch to the Otosure audiometer, and connect the Otosure 

audiometer to the PC via a USB cable. Start the Audibase application on the PC and enter new patient 

details (refer to the Audibase user manual). 

 

 

Start a test using the Launch Test button in the Audibase toolbar 

 

Close any dialogue boxes in the Otosure window and select the Manual Test option: 
 

 

 

Move the mouse pointer over the “Present” icon in the Otosure window and ensure a tone is heard from an 

earphone. Use the arrow keys on the PC keyboard to change the level and frequency of the tone. Use the 

“L” and “R” keys on the PC keyboard to switch between earphones. 

 

Press the patient response switch and ensure that the “Response” icon in the Otosure window changes 

colour to light green and returns to dark green when the switch is released. 
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The above will demonstrate the basic functionality of the audiometer. When closing the Otosure window 

remember to use the “Edit > Cancel Insert/Edit” option or cancel toolbar button in Audibase to cancel the test 

operation. 
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5. USING THE OTOSURE 
 

5.1. EQUIPMENT PREPARATION 
 

Connect the headset and the patient response switch to the Otosure and then make the connection from the 

Otosure to the PC. No specific warm-up time is required although the device registration to the PC might 

take a short time to complete.  

 

5.2. STARTING THE SOFTWARE 

Start the Audibase application, and with reference to the user manual either establish a new a patient, or 

access and display details of an existing patient. 

 

 

Use the left mouse button to click on the Launch Test icon in the Audibase toolbar. 

 

Alternatively use the “Test > Launch Test” drop-down menu selection at the top of the Audibase window. 

 

A new window will open for the Otosure software. If the patient has more than one set of audiometric results 

stored in Audibase the most recent audiogram is transferred and displayed in the Otosure window. 

 

The serial number and calibration date of the connected Otosure audiometer is shown at the bottom right of 

the Otosure window along with the test type currently selected. 

 

The test type last used is remembered; if this was a manual test the procedures may be followed; if this was 

an automatic test the following dialogue box will be displayed: 

 

 

To run the same automatic test using the same options (as last used) 
simply click the “Start test” button and the test will commence. 
 
If a manual test is required, or if the test options are to be modified, 
click the “Modify” button which will close the dialogue box. 

 

5.3. AVAILABLE TEST MODES 

5.3.1. MANUAL TESTING 

This allows the operator to use the Otosure to record hearing level thresholds using the computer’s keyboard 

and mouse. The resulting audiometric data may then be transferred to the Audibase application. 

 

5.3.2. COMPUTER TESTING 

This is a method of automatic audiometry based on the Hughson and Westlake method and undertaken 

automatically by the instrument. The level is increased in 5dB steps until a response is obtained from the 

patient and decreased in 10 dB steps until no response occurs. The process is repeated until, depending 

upon the criteria selected for recording a threshold, the instrument will record a threshold at that particular 

frequency. The Otosure then continues to the next test frequency and so on to complete the test on both 

ears. 
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The Otosure provides the facility to run this test at specified single frequencies and add the results into the 

overall audiogram result. This feature is useful for situations where one particular  

frequency has proved problematic. 

 

5.3.3. MIXED TESTING 

This is typically used when the automatic test has been unable to yield a threshold at one or more 

frequencies. It is possible to perform a manual test (normally at just a few selected frequencies) to complete 

an audiogram by adding thresholds to those already established. 

 

5.4. INITIATING A TEST 

Start the Audibase application, and with reference to the user manual either establish a new a patient, or 

access and display details of an existing patient. 

 

Use the left mouse button to click on the Launch Test icon in the Audibase toolbar. 

 

Alternatively use the “Test > Launch Test” drop-down menu selection at the top of the Audibase window. 

 

A new window will open for the Otosure software. If the patient has more than one set of audiometric results 

stored in Audibase the most recent audiogram is transferred and displayed in the Otosure window. 

 

The serial number and calibration date of the connected Otosure audiometer is shown at the bottom right of 

the Otosure window along with the test type currently selected. 

 

The test type last used is remembered; if this was a manual test the procedures may be followed; if this was 

an automatic test the following dialogue box will be displayed: 

 

 
 

To run the same automatic test using the same options (as last used) simply click the “Start test” button and 

the test will commence. 

 

If a manual test is required, or if the test options are to be modified, click the “Modify” button which will close 

the dialogue box.  
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5.5. CONTROL BUTTONS  

  starts the selected automatic test  

 

  selects Computer test type 

 

  selects Manual test mode 

 

  selects test detail display 

 

  selects audiogram display 

 

 
Sounds a test tone in Manual test mode when the mouse pointer is moved over this icon; 
there is no need to click the mouse button. 
 

 
The icon changes to this format while a tone is being presented 
 

 Please note: The present icon will also be displayed during automatic testing, 
although use of the mouse as described above will have no effect when automatic testing 
is performed. 
 

 

Patient response indicator, displayed like this when the patient has not made a response. 
 

 
The icon changes to this format when a response is made. 
 

 

5.6. CONTROL -  PC KEYBOARD AND MOUSE 

Keyboard, “L” key: selects left ear in Manual test mode 

Keyboard, “R” key: selects right ear in Manual test mode 

Keyboard,  key:  increases the sound level in Manual test mode 

Keyboard,  key:  decreases the sound level in Manual test mode 

Keyboard,  key: selects a lower tone frequency in Manual test mode 

Keyboard, → key: selects a higher tone frequency in Manual test mode 

Mouse, pointer:                    sounds the test tone when positioned over the present icon in Manual test 

mode 

Mouse, left button: selects Windows-based options as normal 

Mouse, right button: in manual test mode only, plots a threshold 

 

5.7. MANUAL TESTING 

Click the Manual test button  (the button will then be highlighted) 

 

Alternatively use the “Test > Manual” drop-down menu selection at the top of the Otosure window. The 

following screen is displayed: 
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Note the cursor positioned in left ear audiogram area indicating the current frequency and dBHL value (also 

displayed at the bottom centre of the Otosure window). 

Moving the mouse over the “Present” icon  will sound the prescribed tone at this level and 

frequency from the left earphone, and the “Present” icon will change to . 

 

If the patient presses the response switch the “Response” icon will change from a dark green colour 

 to a light green colour . 

 

To change the level of the presented tone, use the  and  arrow keys on the PC keyboard. 

 

When confident that a consistent response has been elicited at a particular level the threshold may be 

plotted on the screen by clicking the right mouse button. The numerical value of the threshold is added to the 

appropriate text box above the audiogram. If an error has been made, simply plotting a different threshold at 

the selected frequency will override any previous threshold. 

 

To clear all thresholds from the audiogram use the “Test > Clear readings …” drop-down menu selection and 

select the appropriate items to clear. 

 

To change the frequency of the presented tone, use the  and → arrow keys on the PC keyboard. Continue 

plotting thresholds until all desired frequencies have been tested. 

 

To select the right ear use the “R” key on the PC keyboard, and to return to the left ear use the “L” key. 

 

Use the controls described above to build up a complete audiogram for the patient. Once satisfactorily 

completed, click on “Exit” at the top of the Otosure window and confirm to exit Otosure. The Otosure window 

will close and the Audibase window will display the test results. Refer to the Audibase user manual for 

additional options, but it should be noted that the results must be saved in Audibase to be retained in the 

database. 

 



 USING THE OTOSURE 

  
 

 
 
 

                                                             19 
D-0116492-D (OM022) – Otosure Operating Manual                                                             

5.8. COMPUTER TESTING 

Click the Computer test button (the button will then be highlighted) 

 
 

Alternatively use the “Test > Computer” drop-down menu selection at the top of the Otosure window. A 

screen is displayed but with the “Present” icon and cursor removed. 

 

To run a full Computer test on both ears simply click the “Run selected test” button. 

 
 

Alternatively use the “Test” drop-down menu option to select either a full test or a restricted test (for example, 

limited to a single ear). 

 

The Computer test will run according to the test options selected with the test status indicated at the bottom 

left of the Otosure window. The “Present” icon will re-appear and indicate when tones are presented, and the 

“Response” icon will change to light green when a patient response is made. 

 

To view the traces of the presented tones select the “Show test detail” button: 

 
Alternatively use the “View > Detail” drop-down menu option. 

 

To view the audiogram thresholds select the “Show Audiogram” button: 

 
Alternatively use the “View > Audiogram” drop-down menu option. 

 

The order of frequencies tested, assuming that all frequencies are selected, are 1kHz, 1.5kHz, 2kHz, 3kHz, 

4kHz, 6kHz, 8kHz, 500Hz, 250Hz and 125Hz. 

 

The time available for the patient to respond is from the point the tone is presented to the beginning of the next 

presented tone (approximately 2.3 seconds maximum). If a response is made within this time period a random 

delay is then added to the time until the next tone is presented. 

 

Once the test has been completed successfully the following dialogue box will be displayed: 

 

 
 

If the test has not been completed successfully the following dialogue box will be displayed: 
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To accept the results and transfer them to Audibase click on the “Accept” button. The Otosure window will 

close and the Audibase window will be displayed. Refer to the Audibase user manual for additional options, 

but it should be noted that the results must be saved in Audibase to be retained in the database. 

 

To continue testing click on the “Continue” option. The dialogue box will close and the operator may continue 

testing as described in these sub-sections. 

 

5.9. SINGLE-FREQUENCY TESTING 

In Computer test mode it is possible to run a test at a single frequency. For example, the operator might 

have noticed that the patient response at a particular frequency was erratic, or the automatic test was unable 

to establish a response at a particular frequency. 

 

The “Test > One freq. test” drop-down menu option may be used to select a single frequency for a particular 

ear. Clicking on the required option for frequency and ear initiates a test which will override any audiometric 

data already established for that frequency. At the end of the test the option to “Continue” or “Accept” is 

presented. 

 

5.10. MIXED-MODE TESTING 

This allows an audiogram to be completed by performing tests (typically at a few selected frequencies) using 

an alternative test type. For example, this facility could be used to perform a manual test if the automatic test 

option was unable to establish a threshold at a particular frequency). 

 

The legend “Mixed” is displayed at the bottom right of the Otosure window.  
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6. OPTIONS AVAILABLE TO SET-UP  

6.1. GENERAL 

The Otosure software stores the most recent test configuration and will initially use this to run any 

subsequent tests. However, there are a number of options available for setting up, modifying and controlling 

a test. These are summarised below - please refer to the operating window of the Otosure Software. 

 

6.2. MENU COMMANDS 

Exit: this closes the Otosure window and transfers any audiometric thresholds found plus other test detail to 

Audibase, if the user acknowledges the confirmation. 

 

Test: this provides access to a number of controls as follows: 

• Run full test (tests each ear in turn using the current automatic test type) 

• Left test (tests the left ear only using the current automatic test type) 

• Right test (tests the right ear only using the current automatic test type) 

• One freq. test (tests the selected ear & frequency combination using the current automatic test type) 

• Stop test (displays a further option to confirm or cancel the ‘Stop test’ command; the test continues 
until a response is made; if ‘Stop test’ is confirmed any thresholds found are retained) 

• Clear readings (clears all audiogram & threshold data, or only the data for the left or right ear) 

• Computer (sets Computer to be the current automatic test type) 

• Manual (sets the audiometer into the manual test mode) 
 

View: this allows either test “Detail” (graphical representation of presented tones and patient responses), or 

“Audiogram” (plots of thresholds found) to be selected 

 

Options: this opens a dialogue box, which provides access to the following options: 

 

Video available on how to use different test settings. 

 

• Frequencies – include or exclude 125Hz, 250Hz, 1.5kHz or 8kHz to/from the test regime 

• Computer test - controls to allow: 
o the selection of either 2 out of 3, or 3 out of 5 consistent responses to generate a valid 

threshold 
o a retest of the 1kHz frequency to be omitted (including this function can prove useful in 

correlating test results) 

• Tone response - controls to determine the action to be taken on error: 
o the number of times a frequency is repeated (0, 1, 2 or 3 times) if an error in testing occurs 

(for example, if there is an erratic response from the patient) 
o and then the action to be taken if the error continues (skip the frequency or pause the test) 

• Start level - specify a start level of either 20dBHL, 30 dBHL or 40 dBHL for a test, and for all 
frequencies 1kHz and lower for a Computer test 

• Start with familiarisation - a familiarisation at 1kHz prior to the test 

• Beep on finish - produces an audible tone to alert the operator that the test has finished 
 

Pause: immediately pauses the test and displays furthers options to abort the test, retry the current 

frequency being tested or ignore the current frequency and skip to the next one (skip not for a manual test); if 

the test is aborted any thresholds found are retained 

 

About: displays the version of the Otosure software installed on the PC and the support email address 
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7. TROUBLESHOOTING 

7.1. GENERAL 

The Otosure is straightforward to use with an intuitive user interface, and if the instructions are followed the 

testing process should be performed easily. The product has been designed to detect and report a number 

of errors that could be encountered while performing audiometric testing and these are described below. 

 

7.2. NO INSTRUMENT FOUND 

If the audiometer has not been connected when a test is requested from Audibase the Otosure software will 

not start and the following warning dialogue box will be displayed:  

 

 
 

Clicking OK will return to Audibase. 

 

Use the “Edit > Cancel Insert/Edit” option or cancel toolbar button to cancel the insert operation. The Otosure 

may then be connected and Audibase operations continued. 

 

7.3. NO RESPONSE FROM PATIENT 

If the audiometer detects that no response to the test tone is made by the patient during an automatic test 

the tone level will increase to maximum and then the test will pause with the following message displayed on 

the PC screen: 

 
 

Depending on circumstances the operator may choose to abort the test, retry the frequency, or ignore the 

error (and proceed to testing of the next frequency). 

 

 

 

For a single frequency test, the tone level will also increase to maximum and then the test will pause with the 

following message displayed on the PC screen: 
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Depending on circumstances the operator may choose to retry the single frequency, or cancel the single 

frequency test. 

 

Check that the patient fully understands the instructions previously given regarding use of the response 

switch. Check also that the response switch is connected and operating and that tones are being output from 

the headphones. 

 

7.4. RESPONSE SWITCH HELD ON 

If the audiometer detects that the response switch is not released by the patient during an automatic test the 

tone level will decrease to minimum and then the test will pause with the following message displayed on the 

PC screen: 

 
 

Depending on circumstances the operator may choose to abort the test, retry the frequency, or ignore the 

error (and proceed to testing of the next frequency). 

 

For a single frequency test, the tone level will decrease to minimum and then the test will pause with the 

following message displayed on the PC screen: 

 
 

Depending on circumstances the operator may choose to retry the single frequency, or cancel the single 

frequency test. 

 

Check that the patient fully understands the instructions previously given regarding use of the response 

switch. Check also that the response switch is connected and operating and that tones are being output from 

the headphones. 

 



 TROUBLESHOOTING 

  
 

 
 
 

                                                             24 
D-0116492-D (OM022) – Otosure Operating Manual                                                             

7.5. ERRATIC PATIENT RESPONSE 

If the patient is not consistent in making responses during an automatic test it will not be possible for a 

threshold to be established. In these circumstances, and depending on the test options selected the test may 

be paused or the next test frequency may be presented. If pause is selected, the test will pause with the 

following message displayed on the PC screen: 

 

)  
 

 Please note: This message will not be displayed for a single frequency test, but rather the test will 

complete but with errors (see below). 

 

If the audiometer manages to establish some but not all thresholds during an automatic test the following 

dialogue box will be displayed at the end of the testing process: 

 

 
 
This alerts the operator to the fact that errors in testing have occurred, and allows either: 

• further testing to be continued or 

• the thresholds that were established to be accepted and transferred to Audibase 
 

7.6. EXIT OTOSURE WITH NO RESULTS 

If the Otosure Software is closed without obtaining any test results the following warning will be displayed in 

Audibase: 

 

 
 

Click OK and then use the “Edit > Cancel Insert/Edit” option or cancel toolbar button to cancel the operation. 
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7.7. USB LEAD DISCONNECTED 

If the USB cable connecting the Otosure becomes disconnected any automatic test running will immediately 

cease, and the following message will be displayed: 

 
 

Once the message has been acknowledged, it will be possible to select control buttons and menu options in 

the Otosure window on the PC but these will have no effect. If the Otosure cable becomes disconnected, the 

recommended course of action is for the operator to close the Otosure window and return to Audibase. Then 

use the “Edit > Cancel Insert/Edit” option or cancel toolbar button to remove any data, and close Audibase. 

The Otosure may then be reconnected and Audibase started as usual. 

 

When the Otosure window is closed any thresholds found or plotted will be transferred into Audibase and care 

should therefore be taken with the use of this data. 

 

Please also refer to Section 11 for important information regarding the connection of non-medical electrical 

equipment to medical electrical equipment. 
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8. ROUTINE MAINTENANCE 

8.1. GENERAL MAINTENANCE PROCEDURES 

The performance and safety of the instrument will be maintained if the following recommendations for care 

and maintenance are observed: 

1. It is recommended that the instrument go through at least one annual service, to ensure that the 

acoustical, electrical and mechanical properties are correct. This should be carried out by an 

authorized repairer in order to guarantee proper service and repair. 

2. Observe that no damage is present to the insulation of the mains cable or the connectors and that it 

is not exposed to any kind of mechanical load that could involve damage. 

3. To ensure that the reliability of the instrument is maintained, we recommend that the operator at short 

intervals, for instance once a day, performs a test on a person with known data. This person could be 

the operator.  

4. If the surface of the instrument or parts of it is contaminated, it can be cleaned using a soft cloth 

moistened with a mild solution of water and detergent or similar. Always disconnect the mains power 

adaptor during the cleaning process and be careful that no fluid enters the inside of the instrument or 

accessories. 

5. After each patient examination, ensure that there has been no contamination to the parts touching the 

patient. General precautions must be observed in order to avoid cross-contamination of disease from 

one patient to another. Water should be used for frequent cleaning, but in the case of severe 

contamination it may be necessary to use a disinfectant.  

 

• Before cleaning always switch off and disconnect from the power supply 

• Use a soft cloth lightly dampened with cleaning solution to clean all exposed surfaces 

• Do not allow liquid to come in contact with the metal parts inside the earphones/headphones 

• Do not autoclave, sterilize or immerse the instrument or accessory in any fluid 

• Do not use hard or pointed objects to clean any part of the instrument or accessory 

• Do not let parts that have been in contact with fluids dry before cleaning 

• Rubber ear-tips or foam ear-tips are single use components 

 

Recommended cleaning and disinfection solutions: 

• Warm water with mild, nonabrasive cleaning solution (soap) 

• 70% isopropyl alcohol only on hard cover surfaces 

 

8.2. AUDIOMETER MAINTENANCE 

The Otosure audiometer is a precision instrument. Handle it carefully in order to ensure its continued 

accuracy and service. When cleaning the instrument, use a soft damp cloth and mild detergent to clean the 

instrument panel. Refer to ISO 8253-1 for additional guidance. 

 

CAUTION 
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8.3. HEADSET MAINTENANCE 

Before use check the headset cables and connectors for signs of wear and/or damage. If you find any, 

please replace the item immediately by contacting Amplivox or your Amplivox distributor, requesting the 

relevant part number. 

 

Handle the audiometric headset (and audiocups) with care. For these parts that are in direct contact with the 

patient it is recommended that they are subjected to a standard disinfecting procedure between patients. 

 

This includes physically cleaning and use of a recognised disinfectant. The specific manufacturer's 

instructions should be followed for use of this disinfecting agent to provide an appropriate level of 

cleanliness. 

 

Clean the ear cushions (including those on the Audiocups, if used) with a recognised disinfectant, e.g. a 

“Mediswab”. 

 

 Please note: During the cleaning process do not allow moisture to enter the earphone. 

 

8.4. ACCESSORIES/REPLACEMENT PARTS 

Some reusable components are subject to wear with use over time. We recommend that you keep theses 

replacement parts available. 

 

8.5. REPAIR 

Amplivox Ltd.is only considered to be responsible for the validity of the CE marking, effects on safety, reliability 

and performance of the equipment if: 

• assembly operations, extensions, readjustments, modifications or repairs are carried out by authorized 

persons 

• a 1 year service interval is maintained  

• the electrical installation of the relevant room complies with the appropriate requirements, and 

• the equipment is used by authorized personnel in accordance with the documentation supplied by 

Amplivox Ltd. 

It is important that the customer (distributor) fills out the RETURN REPORT every time a problem arises and 

sends it to  

Amplivox Limited 

3800 Parkside, Solihull Parkway,  
Birmingham Business Park,  
Birmingham, West Midlands,  
B37 7YG  
United Kingdom  

hello@amplivox.com 

This should also be done every time an instrument is returned to Amplivox Ltd. (This of course also applies in 

the unlikely worst case scenario of death or serious injury to a patient or user). 

When packing the instrument for shipping, please use the original shipping carton and packing materials. Place 
the instrument parts in plastic bags before packing. 
 

hello@amplivox.com
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8.6. WARRANTY 

Amplivox therefore gives the purchaser the following Warranty; 

If within twenty-four months from the date of dispatch, any defect in respect of material or workmanship within 
our control is discovered, we will make good the defect without charge, subject to the following conditions; 
 

• Notice of the fault is given to Amplivox within the Warranty period. 

• The instrument is forwarded, carriage paid, to Amplivox Limited at the above address or as otherwise 
directed. 

• The responsibility of Amplivox under this Warranty is strictly limited to making good the defect in the 
instrument itself. 

• No attempt has been made to effect a repair or adjust the calibration or alter the instrument from the 
original build standard.  

• Defects caused by abnormal conditions of use, accident or neglect are expressly excluded. 
 

If any product requires service during the applicable warranty period, the purchaser should communicate 
directly with the local Amplivox Ltd. service center to determine the appropriate repair facility. Repair or 
replacement will be carried out at Amplivox’s expense, subject to the terms of this warranty. The product 
requiring service should be returned promptly, properly packed, and postage prepaid. Loss or damage in return 
shipment to Amplivox Ltd. shall be at purchaser's risk.  
 
In no event shall Amplivox Ltd. be liable for any incidental, indirect or consequential damages in connection 
with the purchase or use of any Amplivox Ltd. product.  
 
This shall apply solely to the original purchaser. This warranty shall not apply to any subsequent owner or 
holder of the product. Furthermore, this warranty shall not apply to, and Amplivox Ltd. shall not be responsible 
for, any loss arising in connection with the purchase or use of any Amplivox Ltd. product that has been:  

• repaired by anyone other than an authorized Amplivox Ltd. service representative;  

• altered in any way so as, in Amplivox Ltd. opinion, to affect its stability or reliability;  

• subject to misuse or negligence or accident, or that has had the serial or lot number altered; defaced 
or removed; or  

• improperly maintained or used in any manner other than in accordance with the instructions 
provided by Amplivox Ltd. 

 
This warranty is in lieu of all other warranties, express or implied, and of all other obligations or liabilities of 
Amplivox Ltd. Amplivox Ltd. does not give or grant, directly or indirectly, the authority to any representative or 
other person to assume on behalf of Amplivox Ltd. any other liability in connection with the sale of Amplivox 
Ltd. products.  
 
AMPLIVOX LTD. DISCLAIMS ALL OTHER WARRANTIES, EXPRESSED OR IMPLIED, INCLUDING ANY 
WARRANTY OF MERCHANTABILITY OR FOR FUNCTION OF FITNESS FOR A PARTICULAR PURPOSE 
OR APPLICATION. 
 

8.7. CALIBRATION AND RETURN OF THE INSTRUMENT  

Amplivox recommends that the Otosure is calibrated annually.  

Please contact Amplivox or the designated distributor for details of calibration services. 
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8.8. GUARANTEE 

All Amplivox instruments are guaranteed against faulty materials and manufacture. The instrument will be 

repaired or replaced free of charge for a period of three years from the date of despatch if returned, carriage 

paid, to the Amplivox service department. Return carriage is free of charge for customers in the UK and 

chargeable for overseas customers. 

 

 Please note: The following exceptions apply: 

The earphones may go out of calibration due to rough handling or impact (dropping). The life of the leads is 

also dependent upon conditions of use. These parts are only guaranteed against faulty materials or 

manufacture. 
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9. TECHNICAL SPECIFICATIONS 

9.1. STANDARDS AND REGULATORY 

The Otosure Audiometer complies with the relevant parts of following standards: 

 

• BS/EN/IEC 60601-1: Medical Electrical Equipment – General requirements for basic safety and 
essential performance 

• BS/EN/IEC 60601-1-2: Medical Electrical Equipment – Electromagnetic Compatibility: Requirements 
and Tests 

• BS/EN/IEC 60645-1: Electroacoustics – Audiological Equipment – Part1: Pure-tone Audiometers 
 

Degree of protection against electric 
shock:  

Type B applied part 

Degree of protection against ingress 
of water: 

Not protected 

Mode of operation: Continuous operation 
Equipment mobility: Portable 

 

The Otosure audiometer is classified as a Class IIa device under Annex IX of the Medical Devices Directive. 

It is intended for transient use as a screening hearing test instrument. 

 

9.2. INPUT/OUTPUT 

Connection to PC:  USB (version 1.0 or 2.0); type B connector 

Left and Right Outputs:  6.3mm Jack Socket 

Patient Response Switch:  6.3mm Jack Socket 

Maximum voltage at any output: 5V peak 

 

9.3. AUDIOMETRIC 

Audiometer type: Type 4 (IEC 60645-1:2001 & ANSI S3.6:2004) 
Frequencies: 125Hz, 250Hz, 500Hz, 1kHz, 1.5kHz, 2kHz, 3kHz, 4kHz, 6kHz, 8kHz 
Frequency accuracy:   <1% 
Distortion:   <2% 
Output level range: -10dB to 100dBHL (80dBHL at 125Hz) 
Output level steps: 5dB 
Output level accuracy:   Within 3dB 
Headset static force: 4.5N 

 

9.4. EARPHONE SOUND ATTENUATION CHARACTERISTICS 

Frequency, Hz 125 250 500 1000 2000 4000 8000 

Attenuation, dB 2 5 7 15 25 31 23 

 

9.5. PHYSICAL & ENVIRONMENTAL 

Audiometer Dimensions: 120mm (L) x 85mm (W) x 30mm (H) 
Audiometer Weight: 150gm 
Operating temperature: +15oC to +35oC 
Storage/transport temperature: -20oC to +70oC 
Humidity (operating): 30% to 90% (non-condensing) 
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Humidity storage/transport): 10% to 90% (non-condensing) 
Atmospheric Pressure (operating): 700hPa to 1060hPa 
Atmospheric Pressure 
(storage/transport):  
 

500hPa to 1060hPa 
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10. EMC GUIDANCE & MANUFACTURER’S 

DECLARATION 

 

• This instrument is suitable in hospital environments except for near active HF surgical equipment 

and RF shielded rooms of systems for magnetic resonance imaging, where the intensity of 

electromagnetic disturbance is high 

• Use of this instrument adjacent to or stacked with other equipment should be avoided because it 

could result in improper operation. If such use is necessary, this instrument and the other equipment 

should be observed to verify that they are operating normally 

• Use of accessories, transducers and cables other than those specified or provided by the 

manufacturer of this equipment could result in increased electromagnetic emissions or decreased 

electromagnetic immunity of this equipment and result in improper operation. The list of accessories, 

transducers and cables can be found in this appendix. 

• Portable RF communications equipment (including peripherals such as antenna cables and external 

antennas) should be used no closer than 30 cm (12 inches) to any part of this instrument, including 

cables specified by the manufacturer. Otherwise, degradation of the performance of this equipment 

could result 

NOTICE 

• ESSENTIAL PERFORMANCE for this instrument is defined by the manufacturer as:  

This instrument does not have an ESSENTIAL PERFORMANCE Absence or loss of ESSENTIAL 

PERFORMANCE cannot lead to any unacceptable immediate risk 

• Final diagnosis shall always be based on clinical knowledge There are no deviations from the 

collateral standard and allowances uses 

• This instrument is in compliance with IEC60601-1-2:2014, emission class B group 1 

NOTICE: There are no deviations from the collateral standard and allowances uses 

NOTICE: All necessary instruction for maintaining compliance with regard to EMC can be found in the 

general maintenance section in this instruction. No further steps required.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

CAUTION 
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Guidance and manufacturer’s declaration – electromagnetic emissions 

The Otosure Audiometer is intended for use in the electromagnetic environment specified below. The 

customer or user of the Otosure Audiometer should assure that it is used in such an environment. 

Emissions test Compliance Electromagnetic environment – guidance 

RF emissions 

 

CISPR 11 

Group 1 The Otosure Audiometer uses RF energy only for its 

internal function. Therefore, its RF emissions are very 

low and are not likely to cause interference in nearby 

electronic equipment. 

RF emissions 

 

CISPR 11 

Class B The Otosure Audiometer is suitable for use in all 

establishments, including domestic establishments 

and those directly connected to the public low-voltage 

power supply network that supplies buildings used for 

domestic purposes. 

Harmonic emissions 

 

IEC 61000-3-2 

Not applicable 

Voltage fluctuations/flicker 

emissions 

 

IEC 61000-3-3 

Not applicable 
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Guidance and manufacturer’s declaration – electromagnetic immunity 

The Otosure Audiometer is intended for use in the electromagnetic environment specified below. The 

customer or user of the Otosure Audiometer should assure that it is used in such an environment. 

Immunity test IEC 60601 test level Compliance level Electromagnetic environment – 

guidance 

Electrostatic 

Discharge (ESD) 

 

IEC 61000-4-2 

±8 kV contact 

 

±15 kV air 

±8 kV contact 

 

±15 kV air 

Floors should be wood, concrete 

or ceramic tile. If floors are 

covered with synthetic material, 

the relative humidity should be at 

least 30% 

Electrical fast 

transient/burst 

IEC 61000-4-4 

±2 kV for power 

supply lines 

±1 kV for input/output 

lines 

Not applicable Mains power quality should be 

that of a typical commercial or 

hospital environment. 

Surge 

 

IEC 61000-4-5 

±1 kV differential 

mode 

±2 kV common mode 

Not applicable Mains power quality should be 

that of a typical commercial or 

hospital environment. 

Voltage dips, short 

interruptions and 

voltage variations on 

power supply input 

lines 

 

IEC 61000-4-11 

<5% UT 

(>95% dip in UT) for 

0.5 cycle 

 

40% UT 

(60% dip in UT) for 5 

cycles 

 

70% UT 

(30% dip in UT) for 

25 cycles 

 

<5% UT 

(>95% dip in UT) for 

5 sec 

Not applicable Mains power quality should be 

that of a typical commercial or 

hospital environment. If the user 

of the Otosure Audiometer 

requires continued operation 

during power mains interruptions, 

it is recommended that the 

Otosure Audiometer be powered 

from an uninterruptible power 

supply or a battery. 

Power frequency 

(50/60 Hz) magnetic 

field 

 

IEC 61000-4-8 

30 A/m 30 A/m Power frequency magnetic fields 

should be at levels characteristic 

of a typical location in a typical 

commercial or hospital 

environment. 

NOTE  UT is the a.c. mains voltage prior to the application of the test level 
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Guidance and manufacturer’s declaration – electromagnetic immunity 

The Otosure Audiometer is intended for use in the electromagnetic environment specified below. The 

customer or user of the Otosure Audiometer should assure that it is used in such an environment. 

Immunity test IEC 60601 

test level 

Compliance 

level 

Electromagnetic environment – guidance 

 

 
 

 

 

 

 

Conducted RF 

IEC 61000-4-6 

 

Radiated RF 

IEC 61000-4-3 

 

 

 

 

 

 

3 Vrms 

150kHz to 

80MHz 

 

3 V/m 

80MHz to 

2.7GHz 

 

 

 

 

 

 

3 Vrms 

150kHz to 

80MHz 

 

3 V/m 

80MHz to 

2.7GHz 

Portable and mobile RF communications 
equipment should be used no closer to any 
part of the Otosure Audiometer, including 
cables, than the recommended separation 
distance calculated from the equation 
applicable to the frequency of the 
transmitter. 
 
Recommended separation distance 

 

d = 1.2√P 

 

d = 1.2√P 80MHz to 800MHz 

 

d = 2.3√P 800MHz to 2.7GHz 

 

where P is the maximum output power rating of the 

transmitter in Watts (W) according to the transmitter 

manufacturer and d is the recommended separation 

distance in metres (m). 

 

Field strengths from fixed RF transmitters, as 

determined by an electromagnetic site survey, a 

should be less than the compliance level in each 

frequency range. b 

 

Interference may occur in the 

vicinity of equipment marked 

with the following symbol: 

 
 

 

 

NOTE 1: At 80MHz and 800MHz, the higher frequency range applies. 
 

NOTE 2: These guidelines may not apply in all situations. Electromagnetic propagation is affected by 

absorption and reflection from structures, objects and people 

a Field strengths from fixed transmitters, such as base stations for radio (cellular/cordless) 

telephones and land mobile radios, amateur radio, AM and FM radio broadcast and TV broadcast 

cannot be predicted theoretically with accuracy. To assess the electromagnetic environment due to fixed 

RF transmitters, an electromagnetic site survey should be considered. If the measured field strength in 

the location in which the Otosure Audiometer is used exceeds the applicable RF compliance level 

above, the Otosure Audiometer should be observed to verify normal operation. If abnormal performance 

is observed, additional measures may be necessary, such as re-orienting or relocating the Otosure 

Audiometer. 

 

b Over the frequency range 150 kHz to 80 MHz, field strengths should be less than 3 V/m. 
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Recommended separation distances between portable and mobile RF communications equipment 

and the Otosure Audiometer 

The Otosure Audiometer is intended for use in an electromagnetic environment in which radiated RF 

disturbances are controlled. The customer or the user of the Otosure Audiometer can help prevent 

electromagnetic interference by maintaining a minimum distance between portable and mobile RF 

communications equipment (transmitters) and the Otosure Audiometer as recommended below, according 

to the maximum output power of the communications equipment. 

Rated maximum 

output power of 

transmitter 

 

W 

Separation distance according to frequency of transmitter 

 

m 

150 kHz to 80 MHz 

 

d = 1.2√P 

 

80 MHz to 800 MHz 

 

d = 1.2√P 

800 MHz to 2.5 GHz 

 

 

d = 2.3√P 

0.01 0.12 0.12 0.23 

0.1 0.38 0.38 0.73 

1 1.2 1.2 2.3 

10 3.8 3.8 7.3 

100 12 12 23 

For transmitters rated at a maximum output power not listed above, the recommended separation distance 

d in metres (m) can be estimated using the equation applicable to the frequency of the transmitter, where P 

is the maximum output power rating of the transmitter in Watts (W) according to the transmitter 

manufacturer. 

 

NOTE 1: At 80MHz and 800MHz, the separation distance for the higher frequency range applies. 

 

NOTE 2: These guidelines may not apply in all situations. Electromagnetic propagation is affected by 

absorption and reflection from structures, objects and people. 

 

NOTE 3 WARNING: Portable RF communications equipment (including peripherals such as antenna cables 

and external antennas) should be used no closer than 30cm (12 inches) to any part of the Otosure 

audiometer including cables specified by the manufacturer. Otherwise degradation of the performance of 

this equipment could result. 

 

  



 USE WITH NON-MEDICAL ELECTRICAL EQUIPMENT 

  
 

 
 
 

                                                             37 
D-0116492-D (OM022) – Otosure Operating Manual                                                             

11. USE WITH NON-MEDICAL ELECTRICAL EQUIPMENT 
Any person who connects external equipment to signal input, signal output or other connectors has created a 

medical electrical system and is therefore responsible for the system complying with the requirements of 

clause 16 of IEC 60601-1:2005 (General requirements for basic safety and essential performance). 

 

If connections are made to standard equipment such as printers and computers, special precautions must be 

taken in order to maintain medical safety. The following notes are provided for guidance in making such 

connections to ensure that the general requirements of clause 16 of IEC 60601-1:2005 are met 

 

The following signal inputs and outputs on the Amplivox Otosure audiometer are electrically isolated to the 

requirements of IEC 60601-1 in order to reduce any potential hazard associated with the use of connected 

mains-powered equipment: 

Socket 
Label 

Socket Type Typical 
Connection 

 

USB Connector Computer 

 

External equipment intended for connection to signal input, signal output or other connectors, shall comply 

with the relevant IEC or international standards (e.g. IEC 60950, CISPR 22 & CISPR 24 for IT equipment, 

and the IEC 60601 series for medical electrical equipment). 
 

Equipment not complying with IEC 60601 shall be kept outside the patient environment, as defined in IEC 

60601-1 (at least 1.5m from the patient). The operator must not touch the connected equipment and the 

patient at the same time as this would result in an unacceptable hazard. 

 

Refer to the diagram below for a typical configuration of a connected computer. Refer to Amplivox Ltd at the 

address given on the front of this user manual if advice is required regarding the use of peripheral 

equipment. 

 

 
 

 

 

 

 

 

 

 

 

 

  

Otosure used with a PC via a USB connection 

Otosure Audiometer 

 
 Mains Outlet 

 

 

 

 

PC via 

USB Socket 

 

 

 

 

 

 

 

 

PC Power Supply 
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